
Upgrading the Cisco ONS 15454 SDH to Release
6.0

This document explains how to upgrade Cisco ONS 15454 SDH Cisco Transport Controller (CTC) software
fromRelease 4.0.x, 4.1.x, 4.5, 4.6.x, 4.7, or 5.x to Release 6.0 using the Advanced Timing, Communications,
and Control (TCC2) or Advanced Timing, Communications, and Control Plus (TCC2P) card.

If you want to upgrade from an earlier software release, log into the Technical Support Website at http://
www.cisco.com/cisco/web/support/index.html for more information or call Cisco TAC (1 800 553-2447).

In releases prior to R4.6 you could independently set proxy server gateway settings; however, with R4.6
and later, this is no longer the case. To retain the integrity of existing network configurations, settings
made in a previous release are not changed on an upgrade to R4.6 or later. Current settings are displayed
in CTC (whether they were inherited from an upgrade, or they were set using the current GUI).

Note

• Errorless Upgrades and Exceptions, page 2

• Document Procedures, page 3

• NTP-U487 Preparing to Upgrade to a New Release, page 4

• NTP-U488 Back Up the Cisco ONS 15454 SDH Software Database, page 5

• NTP-U489 Upgrade the Cisco ONS 15454 SDH Software , page 7

• NTP-U490 Install Public-Key Security Certificate, page 16

• NTP-U491 Restore the Previous Software Load and Database, page 17

• NTP-U105 Upgrade the TCC+ Card to the TCC2/TCC2P Card, page 20

• NTP-U493 Upgrade to the ONS 15454 SDH Software Using TL1, page 22

• Related Documentation, page 28

• Obtaining Documentation and Submitting a Service Request, page 28
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Errorless Upgrades and Exceptions
This section describes important information to be aware of before you begin the upgrade process:

Upgrades from releases prior to 4.6 are not expected to be errorless.Note

Upgrades for dense wavelength divisionmultiplexing (DWDM) configurations are expected to be errorless.Note

On nodes with DS3/EC1-48 cards, where port line buildouts are set to long (for use with 900 ft. cables),
a software upgrade from Release 5.0 or maintenance Release 5.0.2 to any release after 5.0.2 can result in
traffic hits up to 50 ms on the ports set to long line buildout. The length of the hit depends on the operative
slot, port, actual cable length, UBIC type, and cable type. This issue cannot be resolved for upgrades from
the two affected releases. No other release has this issue, and upgrades from Release 5.0 to 5.0.2 are also
not affected.

Note

When upgrading from R5.0 to R6.0 or later in enhanced card mode on nodes running an FC_MR-4 card,
a hitless software upgrade is not possible. This is because the FPGAmust be upgraded to support differential
delay in enhanced mode. However, the upgrade is hitless in the line rate mode.

Note

The following tables define where errorless upgrades or exceptions can occur.

The following table applies to nodes equipped with XC-VXC-10G cards

Expected Traffic EffectCard Type

ErrorlessE3

ErrorlessE1-42

ErrorlessDS31

ErrorlessSTMn

ErrorlessMRC-12

Traffic hits 3 to 8 minutes (approximately)ML-Series Ethernet

Errorless (except as noted)G-Series Ethernet

The following table applies to nodes equipped with XC-VXL-10G or XC-VXL-2.5G cards

   Upgrading the Cisco ONS 15454 SDH to Release 6.0
2 OL-7106-01  

Upgrading the Cisco ONS 15454 SDH to Release 6.0
Errorless Upgrades and Exceptions



Expected Traffic EffectCard Type

ErrorlessE3

ErrorlessE1-42

ErrorlessDS31

ErrorlessSTMn

ErrorlessMRC-12

Traffic hits 3 to 8 minutes (approximately)ML-Series Ethernet

Errorless (except as noted)G-Series Ethernet

The following table applies to nodes equipped with XC10G cards.

Table 1: XC10G

Expected Traffic EffectCard Type

ErrorlessE3

ErrorlessSTM1E

ErrorlessE1-42

ErrorlessSTMn

Traffic hits 3 to 8 minutes (approximately)E-Series Ethernet

Traffic hits 3 to 8 minutes (approximately)ML-Series Ethernet

Errorless (except as noted)G-Series Ethernet

Document Procedures
Procedures in this document must be performed in consecutive order unless noted otherwise. Ensure that the
procedure is completed for each node in a given network. If you are new to upgrading the software, make a
printed copy of this document and use it as a checklist.

Each non-trouble procedure (NTP) is a list of steps designed to accomplish a specific procedure. Follow the
steps until the procedure is complete. If you needmore detailed instructions, refer to the detail-level procedure
(DLP) specified in the procedure steps. Throughout this guide, NTPs are referred as “procedures” and DLPs
as “tasks.” Every reference to a procedure includes its NTP number, and every reference to a task includes its
DLP number.
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The DLP (task) supplies additional task details to support the NTP. The DLP lists numbered steps that lead
you through completion of a task. Some steps require that equipment indications be checked for verification.
When a proper response is not obtained, a trouble clearing reference is provided.

This section lists the document procedures (NTPs). Turn to a procedure for applicable tasks (DLPs).

1 NTP-U487 Preparing to Upgrade to a New Release, on page 4—This procedure contains critical
information and tasks that you must read and complete before beginning the upgrade process.

2 NTP-U488 Back Up the Cisco ONS 15454 SDH Software Database, on page 5—Complete the database
backup to ensure that you have preserved your node and network provisioning in the event that you need
to restore them.

3 NTP-U489 Upgrade the Cisco ONS 15454 SDH Software , on page 7—Complete this procedure to
complete the upgrade.

4 NTP-U490 Install Public-Key Security Certificate, on page 16— Complete this procedure to be able to
run the software.

5 NTP-U491 Restore the Previous Software Load and Database, on page 17— Complete this procedure if
you want to return to the previous software load you were running before activating the new release.

6 NTP-U493 Upgrade to the ONS 15454 SDH Software Using TL1, on page 22— Complete this procedure
only if you want to upgrade to a new release using Transaction Language (TL1).

NTP-U487 Preparing to Upgrade to a New Release
This procedure provides critical information checks and tasks you must
complete before beginning an upgrade to R6.0.

Purpose

Cisco ONS 15454 SDH nodesTools/Equipment

"DLP-G46 Log into CTC" in the "Connect the PC and Log into the GUI"
document.

Prerequisite Procedures

RequiredRequired/As Needed

Onsite or remoteOnsite/Remote

SuperuserSecurity Level
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Procedure

Step 1 Before you begin, make sure that information related to your site, for example, date, street address, site phone
number, and dialup number are stored in a safe and accessible location. The data will be useful during and
after the upgrade.

Step 2 Read the release notes of the release you are upgrading to. Visit http://www.cisco.com/c/en/us/support/
optical-networking/ons-15454-series-multiservice-transport-platforms/products-release-notes-list.html to
download the release notes.

Step 3 Ensure your workstationmeets the minimum hardware and software requirements before starting the upgrade.
For more information on the hardware and software requirements, read the release notes.

Step 4 Make sure that the control cards and cross connect cards are installed in the appropriate slots on all the nodes
in the network and on both the slots as indicated in the following section:

• ONS 15454 SDH shelf -

◦TCC2 or TCC2P cards are in Slots 7 and 11

◦XC-VXL-10G, XC-VXL-2.5G, XC-VXC-10G cards are in Slots 8 and 10

Step 5 Repeat the above step for every node in the network.
Step 6 When you have completed the tasks for this section, proceed with the procedure, NTP-U488 Back Up the

Cisco ONS 15454 SDH Software Database, on page 5.
Stop. You have completed this procedure.

NTP-U488 Back Up the Cisco ONS 15454 SDH Software Database
This procedure retains all configuration data for your network before
performing the upgrade.

Purpose

PC or UNIX workstationTools/Equipment

• "DLP-G46 Log into CTC" in the "Connect the PC and Log into the
GUI" document.

• NTP-U487 Preparing to Upgrade to a New Release, on page 4

Prerequisite Procedures

RequiredRequired/As Needed

Onsite or remoteOnsite/Remote

SuperuserSecurity Level
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(MS-SPRing nodes only) The database must be backed up when using an MS-SPRing.Note

Procedure

Step 1 In the node view, click theMaintenance>Database tabs.
Step 2 In the database pane, click the Backup button.

The Database Backup dialog box is displayed.

Step 3 Click Browse. Navigate to the local PC directory or network directory and type a database name using the IP
address of the node to upgrade (such as database15454SDH010107.db) in the File Name field and clickOK.
To overwrite an existing file, click Yes.

Step 4 When the backup is complete, click OK.
Step 5 Repeat Steps 1 through 5 for each node in the network.
Step 6 (Optional) It is recommended that you manually log critical information by either writing it down, printing

screens, or by exporting the data to an appropriate format, as applicable. Use the following table to determine
the information that should be logged.

When upgrading from Release 4.0.x the previous release’s alarm and audit logs will be deleted due
to changes in the alarm log structure.

Note

Record Data HereInformation

IP address of the node

Node name

Timing settings

DCC1 connections—list all optical ports with active DCCs

User IDs of all users, including at least one Superuser

Inventory—A print screen of the Inventory window

Slot 7 or Slot 11Active TCC2/TCC2P card

Slot 8 or Slot 10Active XC-VXL-10G, XC-VXL-2.5G, or XC-VXC-10G card

Network information—A print screen of the Provisioning tab in the
network view

Current configuration (MS-SPRing, linear, etc.)— A print screen,
as needed

List all protection groups in the system—A print screen of the
Protection group window

List alarms—A print screen of the Alarm window
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Record Data HereInformation

List circuits—A print screen of the Circuit window

1 DCC=data communications channel

Stop. You have completed this procedure.

NTP-U489 Upgrade the Cisco ONS 15454 SDH Software
This procedure upgrades the CTC software to R6.0 and must be
performed on all nodes, or groups of nodes to be upgraded.

Purpose

PC or UNIX workstationTools/Equipment

NTP-U488 Back Up the Cisco ONS 15454 SDH Software Database,
on page 5

Prerequisite Procedures

RequiredRequired/As Needed

Onsite or remoteOnsite/Remote

SuperuserSecurity Level

Do not perform maintenance or provisioning activities during the activation task.Caution

During a parallel upgrade, when end-to-end circuits in anML-Series resilient packet ring (RPR) are present
across multiple nodes, traffic resumes only after all the nodes in these circuits complete activation

Note

Several alarms are raised on the ML-Series cards since they undergo a hard reboot during the upgrade
(cold restart is rarely used). These alarms clear after the upgrade is complete. On the ML-Series port the
LOA, TPTFAIL, and VCG DOWN alarms are raised. On the paths traversed by the ML-Series circuits
the SD-P, SF-P, and PDI-P alarms are raised.

Note
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Procedure

Step 1 Insert the software CD into the workstation CD-ROM drive (or otherwise acquire access to the software) to
begin the upgrade process.

Inserting the software CD activates the CTC Java Setup Wizard. Use the setup wizard to install the
components or click Cancel to continue with the upgrade.

Note

Step 2 (MS-SPRing nodes only) The database must be backed up prior to locking the MS-SPRing. See NTP-U488
Back Up the Cisco ONS 15454 SDH Software Database, on page 5 procedure for details.

Step 3 (MS-SPRing nodes only) Complete the DLP-U547 Perform a MS-SPRing Lockout, on page 10 task.
Step 4 Complete the DLP-U546 Download the ONS 15454 SDH Software, on page 8 task for all nodes to be

upgraded.
Step 5 Complete the DLP-U548 Activate the New Cisco ONS 15454 SDH Software, on page 11 task for all nodes

to be upgraded.
Only one node can be activated at a time. During a parallel upgrade, activate another node as soon
as the controller cards reboot successfully. To perform parallel upgrade remotely, wait five minutes
for the controller cards to reboot completely.

Note

Step 6 Complete the DLP-U549 Delete Cached JAR Files, on page 13 task, as necessary.
Step 7 (Optional) If you want to prevent a software revert to an earlier software release, complete the DLP-U546

Download the ONS 15454 SDH Software, on page 8 task on all nodes, or groups of nodes you are upgrading
a second time.

Step 8 Complete the DLP-U550 Remove the MS-SPRing Lockout, on page 14 task for all MS-SPRing nodes in the
network.

Leave theMS-SPRing in the lockout state until you have finished activating all nodes.Note

Step 9 For MS-SPRing nodes only, complete the DLP-U551 Set the Date and Time, on page 15 task for nodes that
are not using Simple Network Time Protocol (SNTP).

Step 10 If you need to return to the software and database you had before activating Software R6.0, proceed with the
NTP-U491 Restore the Previous Software Load and Database, on page 17 procedure.

Step 11 To back up the Software R6.0 database for the working software load, see NTP-U488 Back Up the Cisco
ONS 15454 SDH Software Database, on page 5 procedure in order to preserve the database for the current
release.
Stop. You have completed this procedure.

DLP-U546 Download the ONS 15454 SDH Software
This task downloads R6.0 software to the ONS 15454 SDH nodes prior
to activation.

Purpose

PC or UNIX workstationTools/Equipment

NTP-U488 Back Up the Cisco ONS 15454 SDH Software Database,
on page 5

Prerequisite Procedures
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RequiredRequired/As Needed

Onsite or remoteOnsite/Remote

Maintenance user or higherSecurity Level

The TCC2/TCC2P card contains flash memory with two partitions—working and protect (backup). The
software is downloaded to the protect (backup) partition of the flash memory on both the standby and
active TCC2/TCC2P cards. This download is not traffic affecting because the active software continues
to run in the primary RAM location. The software can therefore be downloaded at any time.

Note

To download and upgrade the software using TL1, see the NTP-U493 Upgrade to the ONS 15454 SDH
Software Using TL1, on page 22 procedure.

Note

Procedure

Step 1 From CTC View menu, choose Go to Network View.
Step 2 Make sure that the alarm filter is turned off. To do so, complete the following:

a) Click the Filter tool located at the lower-left side of the window.
The Alarm Filter dialog box appears.

b) Click to select any check box that is not selected in the Show Severity section of the General tab.

Step 3 Resolve any outstanding alarms. To view alarms for all the nodes in the network, click the Alarms tab.
The SFTWDOWN alarm is raised on the standby and active TCC2 or TCC2P cards during software
download. The alarms clears as soon as the download is complete.

Note

Step 4 From the CTC View menu, choose Go to Home View to go to the node view.
Step 5 Click theMaintenance> Software tabs.
Step 6 Click the Download button. The Download Selection dialog box appears.
Step 7 Locate the software files on the software CD or on your hard drive.
Step 8 To open the Cisco ONS 15454 SDH folder, choose the file with the PKG extension and click Open.
Step 9 From the list of compatible nodes, select the nodes where the software must be downloaded.

It is recommended that simultaneous software downloads on the section data communications channel
(SDCC) be limited to eight nodes at a time, using the central node to complete the download. If more
than eight concurrent software downloads are selected at a time, it is placed in a queue.

Note

Step 10 Click OK. The Download Status column monitors the progress of the download.
Step 11 Return to your originating procedure (NTP).
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DLP-U547 Perform a MS-SPRing Lockout
This task performs a MS-SPRing lockout. If you have MS-SPRing
provisioned, you must perform this task before beginning the upgrade.

Purpose

PC or UNIX workstationTools/Equipment

NTP-U488 Back Up the Cisco ONS 15454 SDH Software Database, on
page 5

Prerequisite Procedures

Required for MS-SPRing onlyRequired/As Needed

Onsite or remoteOnsite/Remote

Maintenance user or higherSecurity Level

(MS-SPRing nodes only) The database must be backed up prior to locking theMS-SPRing. See NTP-U488
Back Up the Cisco ONS 15454 SDH Software Database, on page 5 procedure for details.

Note

During the activation, MS-SPRing spans are not protected. You must leave the MS-SPRing in the lockout
state until you have finished activating all nodes in the ring. Ensure that the lockout is removed after
activation.

Note

To prevent ring or span switching, perform the lockout on both the east and west spans of each node.Note

Procedure

Step 1 In node view, click theMaintenance tab, then click theMS-SPRing button.
Step 2 For each of the MS-SPRing trunk (span) cards (STM-4, STM-16, STM-64, ,MRC-12, perform the following

steps:
a) Next to the trunk card row, click the East Switch column to show the shortcut menu.
b) From the menu options, choose Lockout Protect.
c) Click the Apply button.
d) In the same row, click theWest Switch column to show the shortcut menu.
e) From the menu options, choose Lockout Protect.
f) Click the Apply button.

Ignore any Default K alarms that occur on the protect VC4 time slots during this lockout
period.

Note
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Certain MS-SPRing-related alarms might be raised following activation of the first node in the ring.
The following alarms, if raised, are normal, and should not cause concern. They clear upon completion
of the upgrade, after all nodes have been activated.

Note

• MSSP-OOSYNC (MN)

• RING-MISMATCH (MJ)

• APSCDFLTK (MN)

• MSSP-RESYNC (NA)

Step 3 Return to your originating procedure (NTP).

DLP-U548 Activate the New Cisco ONS 15454 SDH Software
This task activates the software on each node in the network.Purpose

PC or UNIX workstationTools/Equipment

DLP-U546 Download the ONS 15454 SDH Software, on page 8

DLP-U547 Perform a MS-SPRing Lockout, on page 10 (if required)

Prerequisite Procedures

RequiredRequired/As Needed

Onsite or remoteOnsite/Remote

SuperuserSecurity Level

It is recommended that the first node that is activated be connected via LAN. This ensures that the new
CTC JAR files download to the workstation as quickly as possible.

If a node is provisioned to have no LAN access, the value is overridden in the case of node isolation.
Additionally, if the node is not reachable, the LAN access is turned on. It is recommended that you avoid
node isolation.

Note

Procedure

Step 1 If CTC is not already started, start CTC.
Step 2 Record the IP address of the node. The IP address can be obtained either on the LCD or on the upper left

corner of the CTC window.
Step 3 Make sure that the alarm filter is turned off. To do so, complete the following:

a) Click the Filter tool at the lower-left side of the window.
The Alarm Filter dialog box appears.
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b) Click to select any check box that is not selected in the Show Severity section of the General tab.

Step 4 Make sure that all cards that are part of a 1+1 or Y-cable protection group must be active on the working card
of the protection group and no protection switches are occurring. Also, ensure that traffic carrying protect
cards are in a standby state. To do so, complete the following:
a) In the node view, clickMaintenance > Protection tabs.
b) Select each protection group listed and view the active or standby status of each card in the Selected Group

area.

Step 5 In shelf view, click theMaintenance > Software tabs.
Step 6 Verify that the version in the Protect Version column is R6.0.
Step 7 Click the Activate button. The Activate dialog box displays a warning message.
Step 8 Click Yes to proceed with the activation.

During node activation, all the common control cards (TCC2 or TCC2P) in the node reboot beginning with
the standby card. As soon as the standby card recovers from the reboot, it signals the active card to reset as a
standby card and the standby card transitions to active. An Activation Successful message indicates that the
software is successfully activated.

Step 9 Click OK.
The connection between CTC and the node is lost and CTC displays the Network view. The
INCOMPATIBLE-SW alarm is raised in CTC for the first node that is activated because CTC is unable to
connect to the NE due to differing, incompatible versions of the software between CTC and the NE. A CTC
alert is displayed to update the CTC software. To clear the INCOMPATIBLE-SW alarm, perform steps 10
through 12 only for the first node that is activated on the network.
During the activation process:

•While the second common control card reboots, the standby cross-connect card begins rebooting, followed
by the active cross-connect card.

• The E-Series Ethernet cards reset simultaneously.

• The SYSBOOT alarms are raised when the common control cards and cross-connect card reset. These
alarms clears when all the cards reset.

The activation process can take up to 30 minutes, depending on the number of cards installed in the
node.

• The GCC-EOC, EOC, and EOC-E alarms are transient. These alarms are raised and cleared during the
upgrade process when the control cards and line cards reset.

• Protect cards in the Y-cable protection group boot next, in the order that the protection group was created.

• Other line cards reset one after the other in the order of slot number.

• Next, the traffic cards, G-Series Ethernet cards, CE-Series Ethernet cards, andML-Series Ethernet cards
boot consecutively, in ascending order of slot number with the exception of E1-42 protect cards. E1-42
cards reset before any peer working cards..

If you are upgrading remotely and cannot see the nodes, wait for 5 minutes for the process to complete, then
check to ensure that related alarms have cleared before proceeding.
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Step 10 In CTC, choose File > Update CTC. The CTC software is updated. A CTC alert is displayed to restart CTC.
Step 11 In CTC, choose File > Exit.
Step 12 Start CTC again.
Step 13 (Optional) Run the Cache Loader pre-caching utility. This logs you into CTC at a faster pace after an upgrade.

However, you must log into nodes running releases prior to Software R4.6.
If you do not plan to run the pre-caching utility, it is recommended that the first node you activate
be a LAN-connected node. This ensures that the new CTC JAR files download to your workstation
as quickly as possible.

Note

Perform the following steps to run the Cache Loader.

a) Load the Software CD into your CD-ROM drive. If the directory of the CD does not open automatically,
open it.

b) Double-click the setup.exe file to run the Installation Wizard. The CTC Installation Wizard dialog box
appears.

c) Click the Next button. The Setup Options dialog box appears.
d) Choose Custom, and click the Next button. The Custom Options dialog box appears.
e) Click to select Cisco Transport Controller, and CTC JAR files (deselect any other preselected options)

and click the Next button. A confirmation dialog box appears.
f) Click the Next button again. The CTC Cache Loader pre-caches the JAR files to your workstation,

displaying a progress status box.
g) When the utility finishes, click OK, and in the wizard, click Finish.

Step 14 Click the Launch CTC button in the CTC launcher window.
The new CTC applet loads. The login window is displayed.

Step 15 Type the user name and password and click Login.
Step 16 Return to your originating procedure (NTP).

DLP-U549 Delete Cached JAR Files
This task deletes cached JAR files.Purpose

PC or UNIX workstationTools/Equipment

NonePrerequisite Procedures

You need to complete this task after you activate the first network node.Required/As Needed

Onsite or remoteOnsite/Remote

Maintenance user or higherSecurity Level
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Whenever the CTC software is upgraded or reverted, make sure that the browser and hard drive cache
files are cleared.

Note

Procedure

Step 1 Delete cached files from your browser directory.
In Netscape:

a) Select Edit > Preferences. Click the Advanced tab and click the Cache button.
b) Click the Clear Memory Cache button, and click OK.
c) Click the Clear Disk Cache button, and click OK twice.
In Microsoft Internet Explorer:

a) Select Tools > Internet Options. The Internet Options dialog box appears.
b) Click the General tab, and then click the Delete Files button.
c) Select the Delete all offline content check box.
d) Click OK twice.

Step 2 Close the browser.
Cached JAR files cannot be deleted from the hard drive until the browser is closed. Other applications
that use JAR files must also be closed.

Note

Step 3 On Windows systems, delete cached files from your workstation in this location:
C:\Documents and Settings\username\Application Data\Cisco\CTC

Step 4 Reopen the browser. You should now be able to connect to CTC.
Step 5 Return to your originating procedure (NTP).

DLP-U550 Remove the MS-SPRing Lockout
This task removes aMS-SPRing lockout. Release the
span lockouts on all MS-SPRing nodes after the new
software load is activated on all nodes.

Purpose

PC or UNIX workstationTools/Equipment

DLP-U548Activate the NewCisco ONS 15454 SDH
Software, on page 11

Prerequisite Procedures

Required for MS-SPRingRequired/As Needed

Onsite or remoteOnsite/Remote

MaintenanceSecurity Level
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Procedure

Step 1 In CTC node view, click theMaintenance tab, then click theMS-SPRing button.
Step 2 For each of the MS-SPRing trunk (span) cards (STM-4, STM-16, STM-64, ,MRC-12), perform the following

steps:
a) Next to the trunk card row, click theWest Switch column to show the shortcut menu.
b) From the shortcut menu, click Clear.

When removing a lockout, be sure to apply your changes each time you choose the Clear option.
If you try to select Clear for more than one lockout at a time, you risk traffic loss on the first ring
switch.

Note

c) In the same row, click the East Switch column to show the shortcut menu.
d) From the shortcut menu, click Clear.

Step 3 Repeat this task as many times as necessary to remove all MS-SPRing span lockouts on the upgrade nodes.
Step 4 Return to your originating procedure (NTP).

DLP-U551 Set the Date and Time
This task sets the date and time. If you are not using SNTP, the upgrade
procedure can cause the Date/Time setting to change. Perform this task to reset
the date and time at each node.

Purpose

PC or UNIX workstationTools/Equipment

NonePrerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

SuperuserSecurity Level

If you are using SNTP, this task is not applicable.Note
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Procedure

Step 1 In CTC node view, click the Provisioning > General tabs.
Step 2 Set the correct date and time. Click Apply .
Step 3 Repeat Steps 1 and 2 on all the remaining nodes.
Step 4 Return to your originating procedure (NTP).

NTP-U490 Install Public-Key Security Certificate
This procedure installs the ITU Recommendation
X.509 public-key security certificate. The public-key
certificate is required to run software R4.1 or later.

Purpose

NoneTools/Equipment

This procedure is performed when logging into CTC.
You cannot perform it at any other time.

Prerequisite Procedures

This procedure is required to run software R4.1 or
later.

Required/As Needed

Onsite or remoteOnsite/Remote

Provisioning or higherSecurity Level

Procedure

Step 1 Log into CTC.
Step 2 If the Java Plug-in Security Warning dialog box appears, choose one of the following options:

• Grant This Session—Installs the public-key certificate on the PC only for the current session. After the
session ends, the certificate is deleted. This dialog box appears at the next login into the node.

• Deny—Denies permission to install the certificate. If this option is chosen, login into the node is denied.

• Grant always—Installs the public-key certificate and does not delete it after the session is over. It is
recommended to use this option.

• View Certificate—The public-key security certificate is displayed.

After the completion of the security certificate dialog boxes, the web browser displays information about the
Java and system environments. If this is the first login, a CTC downloading message appears while CTC files
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are downloaded to the computer. The process can take several minutes, if it is the first time. After the download,
the CTC Login dialog box appears.

Step 3 Return to the software and database you had before activating the software, proceed with the NTP-U491
Restore the Previous Software Load and Database, on page 17 procedure.
Stop. You have completed this procedure.

NTP-U491 Restore the Previous Software Load and Database
This procedure returns to the software and database provisioning that was present
before R6.0 was activated.

The software load and database cannot be restored to the previous version if the
software on both the working and protect cards were upgraded to R6.0.

Purpose

PC or UNIX workstationTools/Equipment

"DLP-G46 Log into CTC" in the "Connect the PC and Log into the GUI"
document.

NTP-U487 Preparing to Upgrade to a New Release, on page 4

NTP-U488 Back Up the Cisco ONS 15454 SDH Software Database, on page
5

NTP-U489 Upgrade the Cisco ONS 15454 SDH Software , on page 7

Prerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote

SuperuserSecurity Level

Tasks to revert to a previous load are not part of the upgrade, and are provided here as a convenience to
those wishing to perform a revert after an upgrade. If you have successfully performed all necessary
procedures up to this point, you have finished the software upgrade.

Note

If a node is set to secure, dual-IP mode, the database information is overwritten with this configuration
and cannot be reverted to single-IP repeater mode.

Caution
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Procedure

Step 1 (MS-SPRing nodes only) The database must be backed up prior to locking the MS-SPRing. See NTP-U488
Back Up the Cisco ONS 15454 SDH Software Database, on page 5 procedure for details.

Step 2 (MS-SPRing nodes only) Complete the DLP-U547 Perform a MS-SPRing Lockout, on page 10 task.
Step 3 Complete the DLP-U552 Revert to Protect Load, on page 18 task.
Step 4 (MS-SPRing nodes only) Complete the DLP-U550 Remove the MS-SPRing Lockout, on page 14 task.
Step 5 If the software revert to your previous release failed to restore the database, complete the DLP-U553Manually

Restore the Database, on page 19 task.
Stop. You have completed this procedure.

DLP-U552 Revert to Protect Load
This task reverts to the software you were running prior to the
last activation.

Purpose

PC or UNIX workstationTools/Equipment

NTP-U487 Preparing to Upgrade to a New Release, on page
4

NTP-U488 Back Up the Cisco ONS 15454 SDH Software
Database, on page 5

NTP-U489 Upgrade the Cisco ONS 15454 SDH Software , on
page 7

DLP-U547 Perform a MS-SPRing Lockout, on page 10

Prerequisite Procedures

Required for revertRequired/As Needed

Onsite or remoteOnsite/Remote

SuperuserSecurity Level

To perform a supported (non-service-affecting) revert from R6.0, the release you want to revert to must
have been working at the time you activated to the current software version on that node. Also, a supported
revert automatically restores the node configuration at the time of the previous activation. The exception
to this is when you have downloaded a second time, ensuring that no revert to a previous load can take
place. In this case, the revert occurs, but is not traffic-affecting and does not change the database.

Note
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Ensure that all cards that are part of a protection group (1+1 or Y-cable) are active on the working card
of that protection group and that no protection switches are occurring. To ensure that traffic carrying
protect cards are in a standby state, in the node view click theMaintenance tab, and view the Protect
column for each of the listed protection groups. View the active/standby status of each card in the
Maintenance tab.

Note

Procedure

Step 1 From the node view, click theMaintenance tab, then click the Software button.
Step 2 Verify that the protect software displays the release you upgraded from.
Step 3 Click the Revert button. Revert activates the protect software and restores the database from the previous

load. A confirmation dialog box appears.
Any FPGA downgrades during the revert process may affect traffic. Configuration changes made
after activation are lost when you revert.

Note

Step 4 Click OK. This begins the revert process and drops the connection to the node.
Step 5 Wait until the software revert completes before continuing.

The system reboot may take up to 30 minutes to
complete.

Note

Step 6 Wait one minute before reverting another node.
After you upgrade to JRE 1.4.2, you cannot log into an ONS 15454, ONS 15454 SDH, or ONS 15327
node until you reconfigure the Java Plug-in to use JRE 1.3.1. If you are reverting to a release that
uses JRE 1.3.1_02 and you retained JRE 1.3.1_02 during the upgrade, you do not need to do anything.

Note

Step 7 After reverting all the nodes in the network, restart the browser and log back into the last node that was
reverted. This uploads the appropriate CTC applet to your workstation.

Step 8 Perform the DLP-U549 Delete Cached JAR Files, on page 13 task.
Step 9 Return to your originating procedure (NTP).

DLP-U553 Manually Restore the Database
This task manually restores the database. Use this
task if you were unable to perform a revert
successfully and need to restore the database.

Purpose

PC or UNIX workstationTools/Equipment

DLP-U552 Revert to Protect Load, on page 18

DLP-U550 Remove the MS-SPRing Lockout, on
page 14 (if required)

Prerequisite Procedures

As neededRequired/As Needed

Onsite or remoteOnsite/Remote
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SuperuserSecurity Level

Do not perform these steps unless the software revert failed.Caution

This process is service affecting and should be performed during a maintenance window.Caution

Procedure

Step 1 In CTC node view, click theMaintenance tab, then click the Database button.
Step 2 Click the Restore button. The DB Restore dialog box appears.
Step 3 Click Browse to locate the database file stored on the workstation hard drive or on network storage.
Step 4 Click the database file to highlight it and click Open. The DB Restore dialog box appears.
Step 5 If you need a complete database restore, check theComplete database (System and Provisioning) checkbox.

The following parameters are restored only when theComplete Database (System and Provisioning)
checkbox is checked: node name, IP address, subnet mask and gateway, and IIOP port. If you change
the node name and then restore a backed up database on this node, the circuits automatically map to
the newly renamed node. It is recommended to keep a record of the old and new node names.

Note

Step 6 Click Ok.
The database is restored and the TCC2/TCC2P cards reboot.

Step 7 When the TCC2/TCC2P cards have finished rebooting, log into CTC and verify that the database is restored.
Wait one minute before restoring the next node.

Step 8 Repeat Steps 1 to 7 for each node in the network.
You have now completed the manual database restore.

Step 9 Return to your originating procedure (NTP).

NTP-U105 Upgrade the TCC+ Card to the TCC2/TCC2P Card
This procedure upgrades the TCC+ card to the
TCC2/TCC2P card. The TCC2/TCC2P card supports
ONS 15454 Software R4.x. The TCC+ card is
compatible with ONS 15454 Software R4.0 and
R4.1.x, as well as earlier software versions.

Purpose

Two SONET TCC2 or TCC2P cardsTools/Equipment

NonePrerequisite Procedures
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As neededRequired/As Needed

Onsite or remoteOnsite/Remote

Maintenance or higherSecurity Level

Downgrade procedures from TCC/TCC2P cards to TCC+ cards are not supported. Contact Cisco TAC
for more information.

Note

Procedure

Step 1 Log into CTC.
Step 2 Verify that the LANwires on the backplane are installed properly. The TCC2/TCC2P card does not autodetect

miswired LAN connections. If a LAN connection is miswired, a LANConnection Polarity Reversed condition
appears. For information on installing LAN wires, refer to the Cisco ONS 15454 Procedure Guide.

Step 3 Verify that the node you are upgrading has ONS 15454 Software R4.x installed. The software version is
displayed in the upper left corner of the window.

Step 4 Complete the procedure, NTP-U488 Back Up the Cisco ONS 15454 SDH Software Database, on page 5
before beginning the upgrade.

Step 5 Physically replace the standby TCC+ card on the ONS 15454 with a TCC2/TCC2P card.
a) Check the LED on the faceplate. The ACT/STBY LED on the faceplate of the TCC+/TCC2/TCC2P card

indicates whether the card is in active or standby mode. A green ACT/STBY LED indicates an active card
and an amber light indicates a standby card.

b) Open the standby TCC+ card ejectors.
c) Slide the card out of the slot. This raises the IMPROPRMVL alarm, which clears when the upgrade is

complete.
d) Open the ejectors on the TCC2/TCC2P card to be installed.
e) Slide the TCC2/TCC2P card into the slot along the guide rails.
f) Close the ejectors.
g) In CTC node view, Ldg (loading) appears on the newly installed TCC2/TCC2P card.

The MEA (card mismatch) alarm appears because CTC recognizes a mismatch between TCC
card types. Disregard this alarm; it clears by the end of the procedure.

Note

It takes approximately 10 minutes for the active TCC+ card to transfer the system software and
database to the newly installed TCC2/TCC2P card. During this operation, the LEDs on the
TCC2/TCC2P card flash Fail and then the active/standby LED flashes. When the transfer
completes, the TCC2/TCC2P card reboots and goes into standby mode after approximately three
minutes. Do not remove the card from the shelf during a database transfer.

Note

If your active TCC+ card resets during the upgrade before the new TCC2/TCC2P card is in full
standby mode, remove the new TCC2/TCC2P card immediately.

Caution

Step 6 When the newly installed TCC2/TCC2P card is in standby, right-click the active TCC+ card in CTC.
Step 7 From the pull-down menu, click Reset Card.

Wait for the TCC+ card to reboot. The ONS 15454 switches the standby TCC2/TCC2P card to active mode.
The TCC+ card verifies that it has the same database as the TCC2/TCC2P card and then switches to standby.
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Step 8 Verify that the remaining TCC+ card is now in standby mode (the ACT/STBY LED changes to amber).
Step 9 Physically replace the remaining TCC+ card with the second TCC2/TCC2P card.

a) Open the TCC+ card ejectors.
b) Slide the card out of the slot. This raises the IMPROPRMVL alarm, which clears when the upgrade is

complete.
c) Open the ejectors on the TCC2/TCC2P card.
d) Slide the TCC2/TCC2P card into the slot along the guide rails.
e) Close the ejectors.
The ONS 15454 boots up the second TCC2/TCC2P card. The second TCC2/TCC2P card must also copy the
database. Do not remove the card from the shelf during a database transfer.

When a newly installed TCC2/TCC2P card has a different version of the ONS 15454 software installed
from the version running on the active TCC2/TCC2P card, the newly installed TCC2/TCC2P card
automatically copies the software version running on the active TCC2/TCC2P card. You do not need
to do anything in this situation. However, the loading TCC2/TCC2P card does not boot up in the
normal manner. When the card is first inserted, the red FAIL LED stays on for a short period. The
FAIL LED then blinks normally and all LEDs go dark. After loading the new software for approximately
10 minutes, the TCC2/TCC2P card becomes the standby card and the amber LED is illuminated.

Tip

Step 10 If power-related alarms occur after the second TCC2/TCC2P card is installed, check the voltage on the
backplane. Refer to the Cisco ONS 15454 Troubleshooting Guide for information on clearing alarms.
Stop. You have completed this procedure.

NTP-U493 Upgrade to the ONS 15454 SDH Software Using TL1
This procedure upgrades the software to R6.0 using
TL1 rather than CTC.

Purpose

PC or UNIX workstationTools/Equipment

NTP-U487 Preparing to Upgrade to a New Release,
on page 4

NTP-U488 Back Up the Cisco ONS 15454 SDH
Software Database, on page 5

Prerequisite Procedures

OptionalRequired/As Needed

Onsite or remoteOnsite/Remote

SuperuserSecurity Level
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This procedure assumes you are upgrading using TL1 Release 6.x and later. TL1 commands used prior
to activation to Release 6.x vary in syntax depending on the ONS 15454 release that you are actually
upgrading from. To ensure that your syntax for each command is correct, see the TL1 syntax in the TL1
Command Guide for your particular release when issuing the following commands:

Note

• ACT-USER

• COPY-RFILE

• OPR-PROTNSW-<OCN_TYPE>

• RTRV-COND-ALL

• RTRV-ALM-ALL

• RLS-PROTNSW-<OCN_TYPE>

To download the software using TL1, an FTP server or a terminal emulation program like HyperTerminal
must be running on the workstation.

Note

The download (COPY-RFILE) command is different when downloading software to a gateway network
element (GNE) or an end network element (ENE) under the following conditions:

Note

• FTP is being used.

• Server is set up with a login and password of FTPUSER1 and FTPUSERPASSWORD1.

• FTP server has an IP address of 10.1.1.1.

• FTP server is running on the standard FTP port.

• Software package is called "15454SDH-0xxx-xxxx-xxxx.pkg".

Note

The GNE and ENE commands are as follows:

•When downloading software to a GNE, use a command similar to:

COPY-RFILE:NODENAME:RFILE-PKG:CTAG::TYPE=SWDL,

SRC=“ftp://FTPUSER1:FTPUSERPASSWORD1@10.1.1.1/15454-03xx-A04K-1405.pkg”,

•When downloading software to an ENE, use a command similar to:

COPY-RFILE:NODENAME:RFILE-PKG:CTAG::TYPE=SWDL,

SRC=“ftp://FTPUSER1:FTPUSERPASSWORD1@10.111.11.1:2361@90.90.90.90/15454-03xx-A04K-1405.pkg”;

The ":2361" after the FTP server IP address 10.111.11.1 denotes port 21 on the server.
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The software PKG file in the preceding example is located in the home directory of the FTP server. If the
software PKG file is not in the home directory on the FTP server, insert the directory path where the software
PKG resides between the last IP address and the PKG file in the command line. An example is shown here.

COPY-RFILE:NODENAME:RFILE-PKG:CTAG::TYPE=SWDL,

SRC=“ftp://FTPUSER1:FTPUSERPASSWORD1@10.1.1.1:21@90.90.90.90/CISCO/SOFTWARE/15454-03xx-A04K-1405.pkg”;

Procedure

Step 1 To use TL1 commands, set up an FTP session or use HyperTerminal or a similar terminal emulation package
to establish a session with the node.

Step 2 Type the IP address for the node, using port 3083 or 2361.
The terminal emulation interface displays a warning message and a command prompt (usually >). You can
enter TL1 commands at this prompt.

Step 3 Type the ACT-USER (Activate User) command in the TL1 request window to open a TL1 session:
ACT-USER:[<TID>]:<uid>:<CTAG>::<pid>;

where:

• <TID> is the target identifier (optional).

• <uid> is the Operation Support System (OSS) profile user ID (required).

• <CTAG> is the correlation tag that correlates command and response messages (required).

• <pid> is the password identifier (required).
For example, in the TL1 command:

ACT-USER::CISCO99:100::PASSWORD;

CISCO99 is the user ID, 100 is the correlation tag (used to correlate commands to command responses),
and PASSWORD is the password associated with the user ID.

A response message containing the CTAG that you specified indicates the completion status of the
command.

Step 4 Repeat Step 2 for each node to be upgraded.
Step 5 Type the COPY-RFILE command in the TL1 window or, if you are using HyperTerminal, click Transfer

> Receive File, and use the associated dialog box to select a file to receive. The COPY-RFILE command
downloads a new software package from the location specified by the FTPURL into the inactive flash partition
residing on the controller card.
COPY-RFILE:[<TID>]:<src>:<CTAG>::TYPE=<xfertype>,[SRC=<src1>],[DEST=<dest>],[OVWRT=<ovwrt>],[FTTD=<fttd>];

where:

• <TID> is the target identifier (optional).

• <src> is the source AID (required).

• <CTAG> is the correlation tag that correlates command and response messages (required).

• <xfertype> is the file transfer protocol (required).

• <src1> specifies the source of the file to be transferred (required).

• <dest> is the destination of the file to be transferred (required).
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• <ovwrt> is overwrite. If <OVWRT> is yes, then files should be overwritten. If <OVWRT> is no, then
file transfers will fail if the file already exists at the destination (required).

• <fttd> is the URL format (required).

Step 6 Repeat Step 6 for all nodes to be upgraded.
Step 7 Look for the REPT EVT FXFR message in the TL1 window. REPT EVT FXFR is an autonomous message

used to report the start, completion, and completed percentage status of the software download. REPT EVT
FXFR also reports any failure during the software upgrade, including invalid package, invalid path, invalid
user ID/password, and loss of network connection.
The format of the message is:

REPT EVT FXFR

SID DATE TIME

A ATAG REPT EVT FXFR

"<FILENAME>,<FXFR_STATUS>,[<FXFR_RSLT>],[<BYTES_XFRD>]"

;

where:

• <FILENAME> indicates the transferred file path name and is a string.

• <FXFR_STATUS> indicates the file transferred status: Start, IP (in progress), or COMPLD.

• <FXFR_RSLT> indicates the file transferred result: success or failure. FXFR_RSLT is optional (the
FXFR_RSLT is only sent when the FXFR_STATUS is COMPLD).

• <BYTES_XFRD> indicates the percentage transfer complete and is optional (the BYTES_XFRD is
only sent when the FXFR_STATUS is IP or COMPLD).

Step 8 Complete “NTP-U487 Preparing to Upgrade to a New Release, on page 4” procedure on page 8 for each
node to be upgraded.

Step 9 Complete NTP-U488 Back Up the Cisco ONS 15454 SDH Software Database, on page 5 for each node to
be upgraded.

Step 10 Lock each MS-SPRing span on all the nodes being upgraded using the following command:
OPR-PROTNSW-<OCN_TYPE>:[<TID>]:<AID>:<CTAG>::<SC>,[<SWITCHTYPE>][:<DIRN>];

where:

• <TID> is the target identifier (optional).

• <AID> is the Access IDentifier that indicates the facility in the node to which the switch request is
directed.

• <CTAG> is the correlation tag that correlates command and response messages (optional).

• <SC> is the switch command that is to be initiated on the paths.

• <SWITCHTYPE> is the MS-SPRing switch type.

• <DIRN> is the direction of transmission in which switching is to be made and is relative to the SDH
line or path identified by the AID. The default value is RCV and should be changed to BTH.
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Some nodes might have more than one MS-SPRing. If this is the case, all MS-SPRing spans on all
nodes being upgraded must be locked. Nodes that are not being upgraded do not require MS-SPRing
spans lockouts. Youmust be aware of each span that is part of aMS-SPRing to make sure all necessary
spans are locked.

Note

Ignore any Default K alarms that occur on the protect VC time slots during the lockout.Note

SomeMS-SPRing-related alarms may be raised following activation of the first node in the ring. The
following alarms, if raised, are normal, and should not cause concern. They clear upon completion
of the upgrade, after all nodes have been activated:MS-SPRing-OOSYNC (MN); RING-MISMATCH
(MJ); APSCDFLTK (MN); MS-SPRing-RESYNC (NA).

Note

Step 11 Verify that all necessary MS-SPRing spans on each node being upgraded have been locked out using the
following command:
RTRV-PROTNSW-<OCN_TYPE>:[<TID>]:<AID>:<CTAG>[::::];

where:

• <TID> is the target identifier (optional)

• <AID> is the access identifier that indicates the facility in the node to which the switch request is directed
(must not be null) (required).

• <CTAG> is the correlation tag that correlates command and response messages (optional).

Step 12 Verify that there are no outstanding alarms or conditions on each node using the following commands:
RTRV-PROTNSW-<OCN_TYPE>:[<TID>]:<AID>:<CTAG>[::::];

where:

• <TID> is the target identifier (optional)

• <AID> is the access identifier that indicates the facility in the node to which the switch request is directed
(must not be null) (required).

• <TYPEREQ> is the type of condition to be retrieved. A null value is equivalent to ALL.

RTRV-ALM-ALL:[<TID>]:[<AID>]:<CTAG>::[<NTFCNCDE>],[<CONDITION>],[<SRVEFF>][,,,];

where:

• <TID> is the target identifier

• <AID> is the Access IDentifier that indicates the facility in the node to which the switch request is
directed (must not be null).

• <CTAG> is the correlation tag that correlates command and response messages (optional).

• <NTFCNCDE> is a notification code. A null value is equivalent to ALL.

• <CONDITION> is the type of alarm condition. A null value is equivalent to ALL.

• <SRVEFF> is the effect on service caused by the alarm condition. A null value is equivalent to ALL.

Resolve all issues before proceeding.

You can activate only one node at a time. However, in a parallel upgrade you can begin activation
of the next node as soon as the controller cards for the current node have rebooted successfully. If
you wish to perform a parallel upgrade remotely, wait five minutes for the controller cards to complete
the reboot.

Note

Step 13 Starting at the node farthest from the GNE, type the APPLY command to activate the system software.
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APPLY:[<TID>]::<CTAG>[::<MEM_SW_TYPE>];

where:

• <TID> is the target identifier (optional).

• <CTAG> is the correlation tag that correlates command and response messages.

• <MEM_SW_TYPE> indicates a memory switch action during the software upgrade. MEM_SW_TYPE
is ACT for activate. MEM_SW_TYPE is RVRT to revert.

If the command is successful, the appropriate flash is selected and the TCC2/TCC2P card reboots.

The following occurs:

• Each card in the node reboots, beginning with the standby TCC2/TCC2P card. When the standby
TCC2/TCC2P card reboots, it signals to the active TCC2/TCC2P card that it is ready to take over. When
the active TCC2/TCC2P receives this signal, it resets itself, and the standby TCC2/TCC2P takes over
and transitions to active. The pre-upgrade version of the TCC2/TCC2P card is now the standby
TCC2/TCC2P.

•While the second TCC2/TCC2P is rebooting, the stand by cross-connect card (SONET/SDH only)
reboots, and then the active cross-connect card (SONET only) reboots.

• Next, the E-Series Ethernet cards reset simultaneously.

• Any cards in Y-cable protection groups boot next, one at a time (protect card first), in order of first
creation (refer to the CTC protection group list for order of first creation).

• Next, the traffic cards, G-Series Ethernet cards, CE-Series Ethernet cards, andML-Series Ethernet cards
boot consecutively, in ascending order of slot number, first standby, then working, for each card pair,
with the exception that E1-42 protect cards will always be reset before any of their peer working cards.

• A system reboot (SYSBOOT) alarm is raised while activation is in progress (following the TCC2/TCC2P
and cross-connect card resets). When all cards have reset, this alarm clears. The complete activation
process can take up to 30 minutes, depending on how many cards are installed.

After the common control cards finish resetting and all associated alarms clear, you can safely proceed to the
next step. (If you are upgrading remotely and cannot see the nodes, wait for 5 minutes for the process to
complete, then check to ensure that related alarms have cleared before proceeding.) Repeat this step for each
node that will be upgraded, moving from the furthest node from the GNE toward the GNE itself, which should
be activated last.

Youmight have to log in to each node again to activate the software.Note

Step 14 After all nodes have been activated, log in using CTC or Telnet and verify there are no outstanding alarms.
Step 15 Remove all MS-SPRing lockouts using the following TL1 command:

RLS-PROTNSW-<OCN_TYPE>:[<TID>]:<AID>:<CTAG>[::<DIRECTION>];

where:

• <TID> is the target identifier (optional)

• <AID> is the access identifier that indicates the facility in the node to which the switch request is directed
(must not be null) (required).

• <CTAG> is the correlation tag that correlates command and response messages (optional).

• <DIRECTION> is the direction of transmission (transmit or receive). The possible values are:
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◦RCV—Receive direction only (default)

◦TRMT—Transmit direction only

◦BTH—Both transmit and receive directions

For example:

RLS-PROTNSW-OC48:PETALUMA:FAC-6-1:209::BTH;

Step 16 To back up the database for the working software load, see NTP-U488 Back Up the Cisco ONS 15454 SDH
Software Database, on page 5 in order to preserve the database for the current software.
Stop. You have completed this procedure.

Related Documentation
Use this document in conjunction with the following publications:

• Release notes:
http://www.cisco.com/en/US/products/ps13234/prod_release_notes_list.html

• TL1 command guides:
http://www.cisco.com/en/US/products/hw/optical/ps2006/prod_command_reference_list.html

• Reference guides:
http://www.cisco.com/en/US/products/hw/optical/ps2006/prod_technical_reference_list.html

• Procedure guides:
http://www.cisco.com/en/US/products/hw/optical/ps2006/prod_installation_guides_list.html

• Troubleshooting guides:
http://www.cisco.com/en/US/products/ps13234/prod_troubleshooting_guides_list.html

Obtaining Documentation and Submitting a Service Request
For information on obtaining documentation, submitting a service request, and gathering additional information,
see the monthly What's New in Cisco Product Documentation, which also lists all new and revised Cisco
technical documentation, at: http://www.cisco.com/en/US/docs/general/whatsnew/whatsnew.html

Subscribe to the What's New in Cisco Product Documentation as a Really Simple Syndication (RSS) feed
and set content to be delivered directly to your desktop using a reader application. The RSS feeds are a free
service and Cisco currently supports RSS version 2.0.

Cisco and the Cisco logo are trademarks or registered trademarks of Cisco and/or its affiliates in the U.S. and
other countries. To view a list of Cisco trademarks, go to this URL: http://www.cisco.com/go/trademarks.
Third-party trademarks mentioned are the property of their respective owners. The use of the word partner
does not imply a partnership relationship between Cisco and any other company. (1110R)

   Upgrading the Cisco ONS 15454 SDH to Release 6.0
28 OL-7106-01  

Upgrading the Cisco ONS 15454 SDH to Release 6.0
Related Documentation

http://www.cisco.com/en/US/products/ps13234/prod_release_notes_list.html
http://www.cisco.com/en/US/products/hw/optical/ps2006/prod_command_reference_list.html
http://www.cisco.com/en/US/products/hw/optical/ps2006/prod_technical_reference_list.html
http://www.cisco.com/en/US/products/hw/optical/ps2006/prod_installation_guides_list.html
http://www.cisco.com/en/US/products/ps13234/prod_troubleshooting_guides_list.html
http://www.cisco.com/en/US/docs/general/whatsnew/whatsnew.html
http://www.cisco.com/go/trademarks

	Upgrading the Cisco ONS 15454 SDH to Release 6.0
	Errorless Upgrades and Exceptions
	Document Procedures
	NTP-U487 Preparing to Upgrade to a New Release
	NTP-U488 Back Up the Cisco ONS 15454 SDH Software Database
	NTP-U489 Upgrade the Cisco ONS 15454 SDH Software
	DLP-U546 Download the ONS 15454 SDH Software
	DLP-U547 Perform a MS-SPRing Lockout
	DLP-U548 Activate the New Cisco ONS 15454 SDH Software
	DLP-U549 Delete Cached JAR Files
	DLP-U550 Remove the MS-SPRing Lockout
	DLP-U551 Set the Date and Time

	NTP-U490 Install Public-Key Security Certificate
	NTP-U491 Restore the Previous Software Load and Database
	DLP-U552 Revert to Protect Load
	DLP-U553 Manually Restore the Database

	NTP-U105 Upgrade the TCC+ Card to the TCC2/TCC2P Card
	NTP-U493 Upgrade to the ONS 15454 SDH Software Using TL1
	Related Documentation
	Obtaining Documentation and Submitting a Service Request


